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前    言  
 
 
 
Python 语言诞生于 20 世纪 90 年代，是一种跨平台、开源、面向对象、解释型、动态数据

类型的高级计算机程序设计语言，在 Web 开发、科学计算、人工智能、大数据分析和系统运维

等领域得到广泛应用，深受人们的青睐。不论你是计算机类专业的学生，还是非计算机类专业

的学生，也不论你是否有一定的编程基础，如果你想学习 Python 语言，我们相信这都是一套比

较好的入门教材。 
随着计算机基础教育形式的革新，2018 年，大连民族大学计算机基础实验教学中心成立了

Python 语言课组，课组成员有焉德军、李宏岩、郑江超、隋励丽、杨为明、若曼、郑智强、王

铎等多名老师。从课组成立开始，课组成员多次组织集体备课，进行 Python 语言程序设计集中

学习，并多次参加各类 Python 语言程序设计相关的培训班：2019 年 4 月，Python 语言课组的

五名教师，参加了在长沙举办的第三届全国高校 Python 语言与计算生态教学研讨会；2019 年 7
月，Python 语言课组全体成员参加了在南开大学举办的 Python 语言教学培训班；2019 年 8 月，

Python 语言课组的两名教师，参加了全国高校大数据联盟举办的 Python 编程及大数据分析教师

研修班；2020 年 1 月，Python 语言课组的两名教师，参加了北京雷课教育举办的 Python 人工

智能及大数据分析研修班；2020 年 1 月，Python 语言课组全体成员参加了由东华大学举办的

Python 语言与大数据培训。经过一系列的培训和学习以及课组成员间的交流研讨，我们对于有

关 Python 语言课程的教学内容、教学方法、教学手段等方面有了深刻了解，增强了在全校大范

围开设 Python 语言程序设计课程的信心。2019 年秋季学期，计算机基础实验教学中心停开了

已经开设多年的 VB 程序设计课程和 Access 数据库课程，在全校 5 个学院 21 个专业开设了

Python 语言程序设计课程。 
经过两年的学习和教学实践，Python 语言课组积累了丰富的经验，着手编写适合高校非计

算机专业学生学习的教材《Python 语言程序设计入门》和实验教程《Python 语言程序设计入门

实验指导》。《Python 语言程序设计入门》以全国计算机等级考试二级 Python 语言程序设计考试

大纲为指导，围绕 Python 的基础语法和数据结构组织编排讲授内容，包含 Python 概述、Python
语言基础、Python 程序的控制结构、函数、组合数据类型、文件和数据格式化及模块、包与库

的使用，此外还涉及图形用户界面设计等内容。《Python 语言程序设计入门实验指导》则包含 4
部分内容：与主教材内容相关的 14 个实验项目；《Python 语言程序设计入门》习题解答；Python
语言的二级等级考试大纲和模拟题；网络爬虫、数据分析、数据可视化等项目实训。 

为了更好地开展线上线下混合模式教学，结合教材，我们录制了 44 个 MOOC 教学视频，

总时长 630 分钟，在中国大学 MOOC 的 SPOC 学校专有课程(大连民族大学)上线

(http://www.icourse163.org/course/preview/DLNU-1461020176?tid=1461806466)。同时，基于“百

科园通用考试平台”，我们构建了 Python 语言程序设计题库，为实施过程化考核和形成性评价
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奠定了扎实基础。 
为了更好地开展课程思政，结合教学内容，我们合理地设计了一些课程思政案例，如鸿蒙

操作系统、社会主义核心价值观知识问答程序、习近平总书记在庆祝中华人民共和国成立 70
周年大会上的讲话词频分析、《中共中央关于坚持和完善中国特色社会主义制度、推进国家治理

体系和治理能力现代化若干重大问题的决定》词云图、绘制五星红旗等，所有这些课程思政案

例，与教学内容紧密结合，不突兀，不牵强，因势利导、顺势而为地自然融入，起到润物无声、

潜移默化的效果。在潜移默化中，让学生增长知识，坚定学生的理想信念，激发学生的爱国热

情，培养学生具有民族自信心和维护国家利益的责任感，唤醒学生“为中华之崛起而读书”的

原动力。 
本套教材以程序设计初学者为对象，由浅入深、循序渐进地讲述 Python 语言的基本概念、

基本语法和数据结构等基础知识，包括 Python 语言开发环境的安装、变量与数据类型、程序控

制结构、函数和模块、文件、Python 标准库和第三方库应用等。 
通过学习本套教材，可以让程序设计初学者快速掌握程序设计的基本思想和一般方法，达

到如下目标。 
知识传授目标：使学生掌握 Python 语言的数据类型、基本控制结构、函数设计以及部

分标准库和扩展库的使用；理解文件的基本处理方法；了解当下热门领域的 Python 扩

展库的使用方法。 
能力培养目标：培养学生分析问题、解决问题的能力，培养学生的计算思维和信息素

养，使学生掌握程序设计方法，具备利用 Python 语言编程解决实际问题的能力。 
价值塑造目标：将科技创新、爱国主义精神等思政元素融入教学，着眼于学生道德素

养的熏陶濡染，培养学生一丝不苟、严谨认真、求真务实的工作态度和工匠精神，为

学生学习后续课程、参加工作和开展科学研究打下良好基础。 
在本套教材的编写过程中，我们参阅了很多 Python 语言方面的图书资料和网络资源，借鉴

和吸收了其中的很多宝贵经验，在此向这些作者表示衷心的感谢。由于编者水平有限，书中难

免有疏漏之处，敬请各位同行和读者批评指正，在此表示感谢。我们的邮箱是 992116@qq.com，

电话是 010-62796045。 
本书配套的电子课件、实例源文件和习题答案可以到 http://www.tupwk.com.cn/downpage 网

站下载，也可以扫描下方的二维码下载。 
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 第 1 章  

Python概述 

 
 
 
 
 
Python 诞生于 20 世纪 90 年代，是一种跨平台的、开源的、面向对象的、解释型的、动态

数据类型的高级计算机程序设计语言，在 Web 开发、科学计算、人工智能、大数据分析和系统

运维等领域得到广泛应用，深受人们的青睐。本章将从计算机系统简介开始，让读者初步认识

计算机程序和计算机中的信息表示，了解 Python 程序的开发环境，并理解 Python 程序的执行

过程。 

1.1  计算机系统简介 

1.1.1  计算机系统的组成 

完整的计算机系统包括硬件系统和软件系统两部分，如图 1-1 所示。组成一台计算机的物

理设备的总称就是计算机硬件系统，这是实实在在的物体，是计算机工作的基础。指挥计算机

工作的各种程序的集合称为计算机软件系统，这是计算机的灵魂，是控制和操作计算机工作的

核心。计算机通过执行程序而运行，计算机在工作时需要软硬件协同工作，二者缺一不可。        

 
图 1-1  计算机系统的组成结构 
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 1.1.2  计算机硬件系统 

计算机硬件(Computer Hardware)又称硬件平台，是指计算机系统所包含的各种机械的、电

子的、磁性的装置和设备，如运算器、磁盘、键盘、显示器和打印机等。每个功能部件各尽其

职、协调工作，缺少其中任何一个就不能成为完整的计算机系统。 
计算机能够处理存储的数据。可以说，存储和处理是一个整体：存储是为了处理，处理需

要存储。“存储和处理的整体性”的最初表达是美国普林斯顿大学的冯•诺依曼于 1945 年提出

的计算机体系结构思想，一般称为“程序存储思想”。计算机从 1946 年问世至今都是以这种思

想为基本依据的，主要特点可归结为以下 3 点。 
(1) 计算机由 5 部分组成：运算器、控制器、存储器、输入设备和输出设备。 
(2) 程序和数据存放在存储器中并按地址寻访。 
(3) 程序和数据用二进制表示，与十进制相比，实现二进制运算的结构简单，容易控制。 
如今，半个多世纪过去了，计算机的系统结构发生了很大改变，但就结构原理来说，仍然

是冯•诺依曼型计算机，结构如图 1-2 所示，图中的实线为数据流，虚线为控制流。 

输
入
设
备

输
出
设
备

外存储器

内存储器

运算器

控制器

存储器

 
图 1-2  冯•诺依曼型计算机的结构 

硬件是计算机工作的物质基础，计算机的性能，如运算速度、存储容量、计算精度、可靠

性等在很大程度上取决于硬件的配置。下面简单介绍计算机的 5 个基本组成部分。 

1. 运算器 

运算器的主要功能是进行算术运算和逻辑运算。计算机中最主要的工作就是运算，大量的

数据运算任务是在运算器中进行的。 
运算器又称算术逻辑部件(Arithmetic and Logic Unit，ALU)。 
在计算机中，算术运算是指加、减、乘、除等基本运算。逻辑运算是指逻辑判断、关系比

较以及其他的基本逻辑运算，如与、或、非等。但不管是算术运算还是逻辑运算，都只是基本

运算。也就是说，运算器只能做这些最简单的运算，复杂的运算都要通过基本运算一步步实现。

然而，运算器的运算速度却快得惊人，因而计算机才有高速的信息处理功能。 
运算器中的数据取自内存，运算的结果则送回内存。运算器对内存的读/写操作是在控制器

的控制之下进行的。 

2. 控制器 

控制器是计算机的神经中枢和指挥中心，只有在它的控制之下整个计算机才能有条不紊地
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工作，自动执行程序。控制器的功能是依次从存储器取出指令、翻译指令、分析指令，向其他

部件发出控制信号，指挥计算机各部件协同工作。 
运算器和控制器合称中央处理单元(Central Processing Unit，CPU)。 

3. 存储器 

存储器的主要功能是存放程序和数据。使用时，可以从存储器中取出信息，不破坏原有的

内容，这种操作称为存储器的读操作；也可以把信息写入存储器，原来的内容被抹掉，这种操

作称为存储器的写操作。 
存储器分为程序存储区、数据存储区和栈。程序存储区存放程序中的指令，数据存储区存

放数据。CPU 通过地址总线发出相应的地址，找到存储器中与该地址对应的存储单元，然后通

过数据总线操作存储单元中的数据。 
存储器通常分为内存储器和外存储器。 
1) 内存储器 
内存储器简称内存(又称主存)，是计算机中信息交流的中心。用户通过输入设备输入的程

序和数据最初被送入内存，控制器执行的指令和运算器处理的数据取自内存，运算的中间结果

和最终结果保存在内存中，输出设备输出的信息来自内存，内存中的信息如要长期保存，则应

送到外存储器中。总之，内存要与计算机的各个部件打交道，进行数据交换。因此，内存的存

取速度直接影响计算机的运算速度。 
2) 外存储器 
外存储器设置在主机外部，简称外存(又称辅存)，主要用来长期存放暂时不用的程序和数

据。通常外存不和计算机的其他部件直接交换数据，只和内存交换数据，而且不是按单个数据

进行存取，而是成批地进行数据交换。常用的外存有磁盘、磁带和光盘等。由于外存储器安装

在主机外部，因此也可以归为外部设备。 

4. 输入设备 

输入设备用来接收用户输入的原始数据和程序，并将它们转变为计算机可以识别的形式(二
进制代码)，而后存放到内存中。常用的输入设备有键盘、鼠标、扫描仪、光笔、数字化仪和麦

克风等。 

5. 输出设备 

输出设备用于将存放在内存中的由计算机处理的结果转变为人们所能接受的形式。常用的

输出设备有显示器、打印机、绘图仪和音响等。 

1.1.3  计算机软件系统 

计算机软件(Computer Software)是相对于计算机硬件而言的，包括计算机运行所需的各种程

序、数据以及有关的技术文档资料。只有硬件而没有任何软件支持的计算机称为裸机。在裸机

上只能运行机器语言程序，使用很不方便，效率也低。硬件是软件赖以运行的物质基础，软件

是计算机的灵魂，是发挥计算机功能的关键。 
计算机软件通常可分为系统软件和应用软件两大类。用户与计算机系统各层次之间的关系

如图 1-3 所示。 
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图 1-3  用户与计算机系统各层次之间的关系 

1. 系统软件 

系统软件是管理、监控和维护计算机资源的软件，用来扩大计算机的功能，提高计算机的

工作效率，方便用户使用计算机的软件。系统软件包括操作系统、程序设计语言、语言处理程

序、数据库管理程序、系统服务程序等。 
1) 操作系统 
在计算机软件中，最重要且最基本的就是操作系统(Operating System，OS)。操作系统是最

底层的软件，控制所有在计算机上运行的程序并管理整个计算机的资源，在裸机与应用程序及

用户之间架起了一座沟通的桥梁。没有操作系统，用户就无法自如地应用各种软件或程序。 
目前常见的操作系统有 Windows、UNIX、Linux、Android、macOS、iOS、Blackberry OS

和 HongMeng(鸿蒙)等。 
2) 程序设计语言 
程序设计的基本方法称为 IPO：用户编写程序，输入(Input)计算机；然后由计算机将其翻

译成机器语言并在计算机上运行(Process)；最后输出(Output)结果。计算机语言大致分为机器语

言、汇编语言和高级语言。 
机器语言：机器语言是以二进制代码表示的指令集合，是计算机能直接识别和执行的计算

机语言。优点是执行效率高、速度快；但直观性差，可读性不强，因而给计算机的推广和使用

带来了极大的困难。 
汇编语言：汇编语言是符号化的机器语言，这种语言使用助记符来表示指令中的操作码和

操作数的指令系统。汇编语言相比机器语言前进了一步，助记符比较容易记忆，可读性也好，

但编制程序的效率不高、难度较大、维护较困难，属于低级语言。 
高级语言：高级语言是接近人类自然语言和数学语言的计算机语言，是第三代计算机语言。

高级语言的特点就是与计算机的指令系统无关，因而从根本上摆脱了对机器的依赖，使之独立

于机器，面向过程，进而面向用户。由于易学易记，便于书写和维护，高级语言提高了程序设

计的效率和可靠性。目前广泛使用的高级语言有 C、C++、Java、JavaScript、PHP、HTML、Perl、
Go、LISP 和 Python 等。 

3) 语言处理程序 
将计算机不能直接执行的使用非机器语言编写的程序翻译成能直接执行的机器语言的翻译

程序称为语言处理程序。 
使用各种程序设计语言编写的程序称为源程序，计算机不能直接识别和执行源程序。把计

算机本身不能直接读懂的源程序翻译成机器能够识别的机器指令代码后，计算机才能执行，这

种翻译后的程序称为目标程序。 
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计算机将源程序翻译成机器指令的方法有两种：编译方式和解释方式。编译方式与解释方

式的工作过程如图 1-4 所示。 

   
图 1-4  将源程序翻译成机器指令的过程 

由图 1-4 可以看出，编译方式会使用相应的编译程序把源程序翻译成机器语言的目标程序，

然后链接成可执行程序，运行可执行程序后得到结果。目标程序和可执行程序都以文件方式存

放在磁盘上，再次运行程序时，只需要直接运行可执行程序，而不必重新编译和链接。 
解释方式则把源程序输入计算机，然后使用相应语言的解释程序对代码进行逐条解释、逐

条执行，执行后只能得到结果，而不能保存解释后的机器代码，下次运行程序时需要重新解释

并执行。 
4) 数据库管理系统 
数据库管理系统是能够对数据进行加工、管理的系统软件。常见的数据库管理系统有

MySQL、DB2、Oracle、Access 和 SQL Server 等。 
5) 系统辅助处理程序 
系统辅助处理程序又称“软件研制开发工具”“支持软件”或“工具软件”，主要有编辑

程序、调试程序、装配和连接程序以及测试程序等。 

2. 应用软件 

应用软件是用户利用计算机及系统软件，为解决实际问题而开发的软件的总称。应用软件

一般分为两大类：通用软件和专用软件。 
通用软件支持最基本的应用，如文字处理软件(Word)、表格处理软件(Excel)等。 
专用软件是专门为某一专业领域开发的软件，如财务管理系统、计算机辅助设计(CAD)软

件和仅限于某个部门使用的应用数据库管理系统等。 

1.2  数制与编码 

在计算机系统中，数字和符号都是使用电子元件的不同状态来表示的。根据计算机的这一

特点，我们提出这样的问题：数值在计算机中是如何表示和运算的？这就是本节将要讨论的“数

制”问题。     

1.2.1  数制的基本概念 

通过一组固定的数字(数码符号)和一套统一的规则来表示数值的方法称为数制。数制的种

类很多，除了我们熟悉的十进制之外，还有二十四进制(24 小时为一天)、六十进制(60 秒为 1
分钟、60 分钟为 1 小时)、二进制(手套、筷子等两只/支为一双)等。 
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计算机系统采用二进制的主要原因是电路设计简单、运算简单、工作可靠且逻辑性强。 
不论是哪一种数制，它们的计数和运算都有一些共同的规律和特点。 

1. 逢R进一 

R 是数制中所需数字字符的总数，称为基数(Radix)。例如，十进制使用 0、1、2、3、4、5、
6、7、8、9 这 10 个不同的数制符号来表示数值。在十进制中，基数是 10，表示逢十进一。 

2. 位权表示法 

位权(简称权)是指一个数字在某个位置上所代表的值，处在不同位置的数字所代表的值不

同，每个数字的位置决定了这个数字的值或位权。例如，在十进制数 586 中，5 的位权是 100(即
102)。 

位权与基数的关系是：位权的值是基数的若干次幂。因此，使用任何一种数制表示的数都

可以写成按位权展开的多项式之和。例如，十进制数 256.07 可以用如下形式表示： 
21012

10 107100106105102)07.256( −− ×+×+×+×+×=  
位权表示法的原则是数字的总数等于基数，每个数字都要乘以基数的幂次，幂次是由每个

数字所在的位置所决定的。排列方式是以小数点为界，整数自右向左依次为 0 次方、1 次方、2
次方，以此类推；小数自左向右依次为负 1 次方、负 2 次方，以此类推。 

1.2.2  常用的数制 

在使用计算机解决实际问题的过程中，我们往往使用的是十进制数，而计算机内部使用的

是二进制数。另外，在计算机应用中又经常需要使用十六进制数或八进制数，二进制数因为与

十六进制数和八进制数正好有倍数关系，如 23等于 8、24等于 16，所以十分便于在计算机应用

中进行表示。 

1．十进制数(Decimal) 

按“逢十进一”的原则进行计数，称为十进制数，每一位计满 10 时向高位进 1。对于任意

的十进制数，都可以使用小数点分成整数部分和小数部分。 
十进制数的特点是：数字的个数等于基数 10，逢十进一，借一当十；最大数字是 9，最小

数字是 0，有 10 个数制符号——0、1、2、3、4、5、6、7、8、9；在具体表示时，每个数字都

要乘以基数 10 的幂次。 

2．二进制数(Binary) 

按“逢二进一”的原则进行计数，称为二进制数，每一位计满 2 时向高位进 1。 
二进制数的特点是：数字的个数等于基数 2；最大数字是 1，最小数字是 0，只有两个数制

符号——0 和 1；在数值的表示中，每个数字都要乘以 2 的幂次，这就是每一位的位权。第一位

的位权是 20，第二位的位权是 21，第三位的位权是 22，以此类推。 
例如，二进制数 1101.11 可以表示为： 

210123
2 212121202121)11.1101( −− ×+×+×+×+×+×= 10)75.13(=  

二进制的算术运算与十进制类似，操作简单、直观，更容易实现。 
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3．八进制数(Octal) 

八进制数的进位规则是“逢八进一”，基数 R=8，采用的数制符号是 0、1、2、3、4、5、
6、7，每一位的位权是 8 的幂次。例如，八进制数 376.4 可表示为： 

1012
8 84868783)4.376( −×+×+×+×=  

           5.0687643 ++×+×= 10)5.254(=  
4．十六进制数(Hexadecimal)  

十六进制数的进位规则是“逢十六进一”，基数 R=16，采用的数制符号为 0、1~9、A、B、
C、D、E、F，其中 A～F 分别代表十进制中的 10～15，每一位的位权是 16 的幂次。例如，十

六进制数 3AB.11 可表示为： 
21012

16 161161161116101633AB.11)( −− ×+×+×+×+×= 10)0664.939(≈  
5．常用数制的对应关系 

常用数制的对应关系如表 1-1 所示。 

表 1-1 常用数制的对应关系 

十进制 二进制 八进制 十六进制 

0 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

0 

1 

10 

11 

100 

101 

110 

111 

1000 

1001 

1010 

1011 

1100 

1101 

1110 

1111 

10000 

0 

1 

2 

3 

4 

5 

6 

7 

10 

11 

12 

13 

14 

15 

16 

17 

20 

0 

1 

2 

3 

4 

5 

6 

7 

8 

9 

A 

B 

C 

D 

E 

F 

10 

1.2.3  数制间的转换 

将数由一种数制转换成另一种数制称为数制间的转换。由于计算机采用二进制，而日常生
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活中人们习惯使用十进制，所以计算机在进行数据处理时就必须把输入的十进制数换算成计算

机所能接收的二进制数，计算机运行结束后，再把二进制数换算成人们习惯的十进制数并输出。

这两个换算过程完全由计算机系统自动完成。 

1．二进制数与十进制数之间的转换  

1) 将二进制数转换成十进制数 
将二进制数转换成十进制数的方法前面已经讲过了，只需要将二进制数按位权展开，然后

将各项数值按十进制数相加，便可得到等值的十进制数。例如： 

10
21124

2 )75.22(2121212121)11.10110( =×+×+×+×+×= −−
 

同理，为了将任意进制数转换为十进制数，只需要将数(N)R 写成按位权展开的多项式，然

后按十进制规则进行运算，便可求得相应的十进制数(N)10。 
2) 将十进制数转换成二进制数 
在将十进制数转换成二进制数时，需要对整数部分和小数部分分别进行转换。 
(1) 整数转换。 
整数转换采用除 2 取余法。例如，将(57)10转换为二进制数，用除 2 取余法得： 

 2 57 
2 28 

2 14 

2 7 
2 3 

2 1 
0 

余数 
………1= 
………0= 
………0= a2 
………1= 
………1= 
………1= 

a1 
a0 

a3 
a4 
a5  

结果： 210 )111001()57( =   

(2) 小数转换。 
小数转换采用乘 2 取整法。例如，将(0.834)10转换成二进制数，用乘 2 取整法得： 

 0.834 
×    2 

1.668 
0.668 

×    2 
1.336 
0.336 

×    2 

0.672 
×    2 

1.344 

整数

………1=a-1

………1= a-2

………0= a-3

………1= a-4  
结果： 210 )1101.0()834.0( ≈  
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在对小数部分乘 2 取整的过程中，不一定能使最后的乘积为 0，因此存在转换误差。通常，

当二进制数的精度已经达到预定的要求时，运算便可结束。  
在将带有整数和小数的十进制数转换成二进制数时，必须对整数部分和小数部分分别按除

2 取余法和乘 2 取整法进行转换，之后再将两者的转换结果合并起来即可。  
同理，要将十进制数转换成任意的 R 进制数(N)R，整数转换可采用除 R 取余法，小数转换

可采用乘 R 取整法。 

2．二进制数与八进制数、十六进制数之间的转换  

八进制数和十六进制数的基数分别为 8=23、16=24，所以三位的二进制数恰好相当于一位

的八进制数，四位的二进制数则相当于一位的十六进制数，它们之间的相互转换是很方便的。 
将二进制数转换成八进制数的方法是：从小数点开始，分别向左、向右将二进制数按每三

位一组的形式进行分组(不足三位的补 0)，然后写出与每一组二进制数等值的八进制数。 
例如，将二进制数 100110110111.00101 转换成八进制数，结果是： 

82 )12.4667()00101.111001101101( =  

将八进制数转换成二进制数的方法恰好与将二进制数转换成八进制数相反：从小数点开始，

分别向左、向右将八进制数的每一位数字转换成三位的二进制数即可。 
将二进制数转换成十六进制数的方法和二进制数与八进制数之间的转换方法相似，从小数

点开始，分别向左、向右将二进制数按每四位一组的形式进行分组(不足四位的补 0)，然后写出

与每一组二进制数等值的十六进制数。 
例如，将二进制数 1111000001011101.0111101 转换成十六进制数，结果是： 

(1111000001011101.0111101)2=(F05D.7A)16 

类似地，在将十六进制数转换成二进制数时，可按相反的过程进行操作。 

1.2.4  数据在计算机中的表示方式 

计算机中处理的数据可分为数值型数据和非数值型数据两类。数值型数据是指数学中的代

数值，具有量的含义，如 235、-328.45 或 3/8 等；非数值型数据是指输入计算机中的所有文字

信息，没有量的含义，如数字 0～9、大写字母 A～Z 或小写字母 a～z、汉字、图形、声音及一

切可印刷的符号+、-、！、#、%等。 
由于计算机采用二进制，因此这些数据在计算机内部必须以二进制编码的形式表示。也就

是说，一切输入计算机中的数据都是由 0 和 1 两个数字进行组合的。数值型数据有正负之分，

数学中使用符号+和-来分别表示正数和负数，但在计算机中，数的正负符号也要使用 0 和 1 来

表示。 

1．有符号数的表示方法 

在计算机中，有符号的数通常使用原码、反码和补码 3 种形式来表示，这么做的主要目的

就是解决减法运算的问题。任何正数的原码、反码和补码形式都完全相同，而负数的原码、反

码和补码形式则不同。 
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1) 数的原码表示 
正数的符号位用 0 表示，负数的符号位用 1 表示，有效值部分用二进制绝对值表示，这种

表示法称为原码。原码对 0 的表示方法不唯一，分为正的 0(000…00)和负的 0(100…00)。 
2) 数的反码表示 
正数的反码和原码相同，负数的反码则是对原码的除符号位外的其他各位取反：0 变 1，1

变 0。 
例如：(+76)原 = (+76)反 =01001100 

(-76)原 = 11001100  (-76)反 = 10110011 
可以验证，任意数的反码的反码即为原码本身。 
3) 数的补码表示 
正数的补码和原码相同，负数的补码则需要对反码加 1。 
例如：(+76)原 = (+76)反 = (+76)补 = 01001100 

(-76)原 = 11001100  (-76)反 = 10110011  (-76)补 = 10110100 
可以验证，任意数的补码的补码即为原码本身。 

2．定点数与浮点数 

数值除了有正负之分以外，还有带小数点的数值。当所要处理的数值含有小数部分时，计

算机就必须解决数值中的小数点的表示问题。在计算机中，通常采用隐含规定小数点的位置这

种形式来表示带小数点的数值。 
根据小数点的位置是否固定，数的表示方法可以分为定点整数、定点小数和浮点数 3 种类

型。定点整数和定点小数统称为定点数。 
1) 定点整数 
定点整数是指小数点隐含固定在整个数值的最后，符号位右边的所有位数表示的是整数。

如果用 8 位表示定点整数，那么 00000110 表示二进制数+0000110，也就是十进制数+6。 
2) 定点小数 
定点小数是指小数点隐含固定在某个位置的小数。人们通常将小数点固定在最高数据位的

左边。如果用 8 位表示定点小数，那么 01100000 表示二进制数+0.1100000，也就是十进制数

+0.75。 
由此可见，定点数可以表示纯小数和整数。定点整数和定点小数在计算机中的表示并没有

什么区别，小数点完全靠事先约定而隐含在不同位置。 
3) 浮点数 
浮点数是指小数点位置不固定的数，浮点数既有整数部分又有小数部分。在计算机中，通

常把浮点数分阶码(也称为指数)和尾数两部分进行表示。其中：阶码用二进制定点整数表示，

尾数用二进制定点小数表示，阶码的长度决定数的范围，尾数的长度决定数的精度。为保证不

损失有效数字，通常还会对尾数进行规格化处理，从而保证尾数的最高位为 1。实际数值可通

过阶码进行调整。 
浮点数的格式多种多样。例如，某计算机用 32 位表示浮点数，阶码部分为 8 位补码的定点

整数，尾数部分为 24 位补码的定点小数。浮点数的最大特点在于比定点数表示的数值范围大。 
例如，二进制的+110110 等于 26×0.110110，阶码为 6，也就是二进制的+110，尾数为
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+0.110110。浮点数的表示形式如图 1- 5 所示。 

 
图 1-5  浮点数示例 

1.2.5  字符编码 

字符编码(Character Encoding)是指把字符集中的字符编码为指定集合中的某一对象(如自然

数序列等)，以便文本在计算机中存储和通过通信网络进行传递，常见的例子包括将拉丁字母表

编码成摩斯电码和 ASCII(American Standard Code for Information Interchange，美国信息交换标

准码)。 

1．西文编码 

目前使用最广泛的西文字符集及其编码是 ASCII 字符集和 ASCII 码，ASCII 同时也被国际

标准化组织(International Organization for Standardization，ISO)批准为国际标准。ASCII 将字母、

数字和其他符号使用 0~127 的整数进行编号，并用 7 个二进制位(bit，比特)表示这种整数。另

外，我们通常额外使用一个扩充的二进制位，以便以 1 字节(Byte)的方式进行存储，最高位通

常用于奇偶校验。 
基本的 ASCII 字符集共有 128 个字符，其中有 96 个可打印字符，包括常用的字母、数字、

标点符号等，另外还有 32 个控制字符，如附录所示。 
字母和数字的 ASCII 码值的记忆非常简单，只要记住一个字母或数字的 ASCII 码值(例如， 

0 的 ASCII 码值为 48，A 的 ASCII 码值为 65，a 的 ASCII 码值为 97)，就可以推算出其余大小

写字母、数字的 ASCII 码值。 

2．中文编码 

为了扩充 ASCII 编码，以显示本国的语言，不同的国家和地区制定了不同的标准，由此产

生了 GB2312、BIG5、JIS 等编码标准。这些编码标准使用 2 字节来代表一个字符的各种汉字延

伸编码方式，称为 ANSI 编码，又称 MBCS(Muilti-Bytes Character Set，多字节字符集)。在简体

中文操作系统下，ANSI 编码代表 GB2312 编码；在日文操作系统下，ANSI 编码代表 JIS 编码。 
GB2312 编码通行于我国内地，是于 1980 年发布的《信息交换用汉字编码字符集 基本集》，

标准号为 GB 2312—1980，通常被称为国标码。几乎所有的中文系统和国际化的软件都支持

GB2312。 
GB2312 是简体中文字符集，由 6763 个常用汉字和 682 个全角的非汉字字符组成。其中汉

字根据使用的频率分为两级：一级汉字(常用汉字)3755 个，按汉语拼音字母排列；二级汉字(不
常用汉字)3008 个，按偏旁部首排列。 

区位码是指每个汉字的 GB2312 编码的对应表示，以 4 位的十进制数字表示，前两位称为

“区码”，后两位称为“位码”，共分为 94 区和 94 位。例如，汉字“中”的区位码为 54 48，
转换为十六进制后就是(36)16(30)16，其中区码为 54、位码为 48。 

为了与 ASCII 码一致，避开 ASCII 码中的前 32 个非图形字符，将区位码的区码和位码分
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别加上十进制数 32[或(20)16]，便得到国标码。例如，汉字“中”的国标码为 86 80，对应的十

六进制表示为(56)16(50)16，通常表示为 5650H(H 在这里代表十六进制)。 
汉字机内码采用 2 字节存储一个汉字，为了避免与 ASCII 码冲突而出现二义性，在将国标

码转换为机内码时对每字节(8 个二进制位)“高位加 1”，这等同于对汉字国标码的十六进制表

示加(80)16，也就是加 80H。所以，汉字的国际码与其内码之间的关系是：汉字的机内码=汉字

的国际码+8080H。 
汉字输入码(外码)是指用户从键盘上输入汉字时使用的汉字编码，常用的汉字输入码有拼

音编码(如全拼、双拼、微软拼音输入法、自然码、智能 ABC、搜狗等)、字形编码(五笔、表形

码、郑码输入法等)。 
GB2312 的出现，基本满足了汉字的计算机处理需要，但对于人名、古汉语等方面出现的

罕用字，GB2312 处理不了，这导致后来 GBK 及 GB18030 汉字字符集的出现。 
另外，在我国的香港、澳门特别行政区和台湾地区，普遍使用的是繁体中文字符集。为了

统一繁体字符集编码，1984 年，制定了繁体中文编码方案 Big5。在互联网中检索繁体中文网站

时，所打开的网页大多都是通过 Big5 编码产生的文档。 

3．Unicode 编码 

不同 ANSI 编码之间互不兼容，当信息在国际上交流时，无法将属于两种语言的文字，存

储在同一段 ANSI 编码的文本中。ANSI 编码最大的缺点是，同一个编码值，在不同的编码体

系里代表着不同的汉字，这就很容易造成混乱，并且导致 Unicode 编码的诞生。 
Unicode 作为编码方案，是为了解决传统字符编码方案的局限性而产生的，它为每种语言

中的每个字符设定了统一且唯一的二进制编码，可以容纳 100 多万个符号，以满足跨语言、跨

平台进行文本转换、处理的要求。 
Unicode 虽然统一了编码方式，但是效率不高，比如 UCS-4(Unicode 的标准之一)规定用 4

字节存储一个符号，那么每个英文字母必然有 3 字节是 0，这对存储和传输来说都十分耗费资

源，于是出现了 UTF-8 编码。 
UTF-8(8-bit Unicode Transformation Format)是针对 Unicode 的一种可变长度字符编码，可用

来表示 Unicode 标准中的任何字符，而且其编码中的第一个字节与 ASCII 相容。目前，UTF-8
逐渐成为电子邮件、网页及其他存储或传送文字应用中优先使用的编码，Python 3.x 默认使用

UTF-8 编码。 

1.3  Python 语言简介 

1.3.1  Python 语言发展简史 

Python 是由荷兰人 Guido Van Rossum 于 1989 年圣诞节期间，在阿姆斯特丹，为了打发圣

诞节的无趣而开发的一种解释型脚本语言。 
Python 本身也是由诸多其他语言发展而来的，包括 ABC、C、C++、SmallTalk、UNIX shell

以及一些其他的脚本语言等。 
1991 年，Python 的第一个解释器诞生了。它是用 C 语言实现的，有很多语法来自 C，但又
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受到了很多 ABC 语言的影响。 
1994 年 1 月，Python 1.0 发布了。这个版本的主要新功能是 lambda、map、filter 和 reduce。 
2000 年 10 月，Python 2.0 发布了。这个版本的主要新功能是内存管理、循环检测垃圾收集

器以及对 Unicode 的支持。 
2008 年 12 月，Python 3.0 发布了。Python 3.x 不向后兼容 Python 2.x，这意味着 Python 3.x

可能无法运行使用 Python 2.x 编写的代码。Python 3.0 代表着 Python 语言的未来。 
2019 年 10 月，Python 3.8 发布了。 
自从 2004 年以后，Python 的使用率呈线性增长。 
2011 年 1 月，Python 被 TIOBE 编程语言排行榜评为 2010 年年度编程语言；2019 年 1 月，

Python 被评为 2018 年年度编程语言，8 年后 Python 重登王座。  
在 IEEE Spectrum 2017 年年度编程语言排行榜上，Python 夺冠；在 IEEE Spectrum 2018 年

年度编程语言排行榜上，Python 卫冕；在 IEEE Spectrum 2019 年年度编程语言排行榜上，Python
依然是榜单状元。Python 在 IEEE Spectrum 年度编程语言排行榜上连续三年排名第一，已经成

为世界上最受欢迎的编程语言。  

1.3.2  Python 语言的特点 

(1) 入门简单：Python 有相对较少的关键字，结构简单，语法定义明确。阅读编写良好的

Python 程序，感觉就像读英语，非常接近自然语言，学习起来更加简单。Python 的这种伪代码

风格，也使得人们在利用 Python 解决问题时，能够更多地专注于问题本身而不是语言的细节。 
(2) 免费开源：Python 是自由/开放源代码软件(Free/Libre and Open Source Software，

FLOSS)。使用者可以自由地发布软件的副本、阅读源代码、对代码进行改动并用于新的软件中，

但不需要支付费用，也不涉及版权问题。 
(3) 高层语言：在编写 Python 程序时，无须考虑诸如如何管理程序使用的内存之类的底层

细节。 
(4) 良好的可移植性：Python 的开源本质，决定了它可以被移植到许多平台上，包括 Linux、

Windows、Macintosh、Solaris 及 Android 等。作为脚本语言，Python 程序可以在任何安装了解

释器的计算机环境中执行，实现了“一次编写，到处运行”。 
(5) 易于维护：Python 语言通过强制缩进体现语句间的逻辑关系，提高了程序的可读性，

增强了程序的可维护性。 
(6) 解释型语言：使用 Python 语言编写的程序，可以直接从源代码运行。在计算机内部，

Python 解释器把源代码转换成字节码，再翻译成机器语言并运行。Python 的解释型语言特性，

使得用户可以将一些代码行在交互方式下直接测试执行，既提高了开发速度，也易于程序的编

写与调试。 
(7) 面向对象：Python 既支持面向过程编程，也支持面向对象编程。在“面向过程”的编

程语言中，程序是用过程或仅仅包含可重用代码的函数构建起来的。在“面向对象”的编程语

言中，程序是用数据和功能组合而成的对象构建起来的。Python 是完全面向对象的编程语言，

一切皆对象，函数、模块、数字、字符串等都是对象。Python 以一种非常强大而又简单的方式

实现了面向对象编程。 
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(8) 可扩展性：Python 提供了丰富的 API 和工具，以便程序员能够轻松地使用 C/C++语言

来编写扩充模块。 
(9) 广泛的标准库：Python 有非常庞大的标准库，例如 math、random、time、turtle、json

等，可以帮助你处理各种工作，只要安装了 Python，所有这些功能都可以使用。 
(10) 丰富的第三方库：除了标准库以外，Python 还有大量的第三方库，例如 NumPy、SciPy、

SymPy、matplotlib、scikit-learn、Requests、Scrapy、wxPython、Pygame、Django、jieba、PyInstaller
等，为我们解决各类问题提供了强大的工具。利用合适的第三方库不仅可以节省开发时间，满

足各种复杂的需求，更重要的是，合理利用这些资源会使学习与开发变得更加便利与高效。 
(11) 运行速度慢：Python 是解释型语言，源代码在执行时会逐行翻译成机器代码，翻译过

程比较耗时，所以运行速度相对较慢。 

1.3.3  Python 语言的应用领域 

Python 语言的应用领域十分广泛，覆盖了 Web 开发、科学计算、系统运维、游戏开发、

GUI 编程、数据库编程、大数据分析、人工智能等诸多领域。 
(1) Web 开发：Python 提供丰富的模块以支持 Socket 编程和多线程编程，能方便、快速地

开发网络服务程序。Python 还拥有优秀的 Django、Tornado、Flask 等 Web 开发框架，并且得到

众多开源插件的支持，足以适用各种不同的 Web 开发需求。 
(2) 科学计算：随着 NumPy、SciPy、matplotlib 和 Pandas 等众多程序库的开发，Python 越

来越适合于进行科学计算以及绘制高质量的 2D 和 3D 图像。 
(3) 系统运维：Python 标准库包含多个用于调用操作系统功能的库。例如，通过第三方软

件包 pywin32，Python 能够访问 Windows API；通过 IronPython，Python 程序能够直接调用.NET 
Framework。Python 已成为运维工程师首选的编程语言，在自动化运维方面深入人心。 

(4) 大数据分析：Python 是大数据分析的主流语言之一，网络爬虫是大数据行业获取数据

的核心工具，Google 等搜索引擎公司大量地使用 Python 编写网络爬虫。目前，Scrapy 爬虫框

架的应用非常广泛，该框架就是使用 Python 实现的。 
(5) 人工智能：Python 已是人工智能领域主流的编程语言。目前世界上一些十分优秀的人

工智能学习框架，如 TensorFlow、Theano、Keras 等，都是使用 Python 实现的。 

1.4  Python 语言开发环境 

1.4.1  下载和安装 Python 

在学习 Python 语言之前，首先要搭建编程环境。Python 可以安装在 Linux、Windows、Mac 
OS X、iOS 等主流平台上。本节以 Windows 为例，介绍 Python 的安装过程。 

在 Windows 上安装 Python 和安装普通软件一样简单，下载安装包以后，基本上单击“下

一步”按钮即可。 
进入 Python 官网下载页面：https://www.python.org/downloads/，如图 1-6 所示。 
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图 1-6  Python 官网下载页面 

目前最新的版本是 Python 3.8.2，单击图 1-6 中的版本号或 Downloads 选项，进入对应版本

的下载页面，滚动到最后即可看到 Python 安装包，如图 1-7 所示。 

 
图 1-7  Python 安装包页面 

关于 Python 安装包的几点说明： 
以 Windows x86-64 开头的是 64 位的 Python 安装程序。 
以 Windows x86 开头的是 32 位的 Python 安装程序。 
 embeddable zip file 表示.zip 格式的绿色免安装版本。 
web-based installer 表示通过网络进行安装。 
 executable installer 表示.exe 格式的可执行程序，通常选择此类安装包。 
选择 Windows x86-64 executable installer，这是 64 位的完整的离线安装包，单击“下载”

按钮，将文件保存到指定的文件夹中，如图 1-8 所示。 

 

 
图 1-8  下载 Python 安装包 



 

 16 

双击得到的 python-3.8.2-amd64.exe，也可在图 1-8 中直接单击“下载并运行”按钮，就可

以正式开始安装 Python 了，如图 1-9 所示。 

 
图 1-9  Python 安装界面 

在图 1-9 中选中 Add Python 3.8 to PATH 复选框，这样就可以将 Python 命令工具所在目录

添加到 PATH 环境变量中了，以后开发程序或运行 Python 命令将会非常方便。 
Python 支持两种安装方式：默认安装和自定义安装。默认安装会选择所有组件，并将它们

安装到 C 盘上；自定义安装则允许你手动选择想要安装的组件，并将它们安装到其他磁盘上。 
在这里，我们选择自定义安装，可将 Python 安装到常用目录下以免 C 盘文件过多。单击

Customize installation 选项，进入下一个界面。 
选择想要安装的 Python 组件，若没有特殊要求，保持默认即可，如图 1-10 所示。 

 
图 1-10  Python 的可选组件界面 

单击 Next 按钮，进入 Python 的高级选项界面，进行安装目录的选择等设置，如图 1-11
所示。 
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图 1-11  Python 的高级选项界面 

单击 Install 按钮进行安装，安装完毕后会弹出安装成功界面，如图 1-12 所示。 

 
图 1-12  Python 的安装成功界面 

Python 安装成功后，在 Windows 系统的“开始”菜单中，找到 Python 3.8 文件夹，单击该

文件夹，你将会看到如图 1-13 所示的 Python 命令。 

 
图 1-13  Python 命令 
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图 1-13 所示 Python 命令的含义如下。 
 ：启动 Python 自带的集成开发环境。 
 ：启动 Python 的命令行交互环境解释器。 
 ：打开 Python 的帮助文档。 
 ：以内置服务器的方式打开 Python 模块的帮助文档。 
图 1-14 展示了 Python 的命令行交互环境解释器，在 Python 的提示符>>>后输入 Python 语

句 print("Hello World!")，按回车键即可解释执行，得到运行结果。 

 
图 1-14  Python 的命令行交互环境解释器 

这是字符界面，使用起来不太方便。我们通常使用的是 Python 自带的集成开发环境 IDLE，
当然也可以使用其他一些集成开发环境，如 PyCharm、Spyder、Vim 等。 

1.4.2  内置的 IDLE 开发环境 

在 Windows“开始”菜单的“所有程序”中选择 Python 3.8 的 IDLE(Python 3.8 64-bit )命令，

即可打开 Python 自带的集成开发环境 IDLE。运行 IDLE 后，首先看到的是主窗口——Python 
3.8.2 Shell，这是一个解释器，在这个解释器的提示符>>>后输入一条 Python 语句，例如

print("Hello,World!")，按回车键，IDLE 会立即解释执行这条语句，并显示运行结果。这样的解

释器通常被称为 shell。 
这是一种交互模式的 Python 程序，解释器即时响应用户输入的语句，并给出相应的输出结

果。这种方式每次只执行一条语句，适用于调试少量代码。 
另一种是文件模式的 Python 程序，可将语句按 Python 语法格式要求写在文件中，保存为.py

形式的文件，然后启动 Python 解释器，批量执行文件中的语句。具体操作步骤如下： 
(1) 在图 1-15 所示的主窗口中依次选择 File→New File 命令，如图 1-16 所示，即可新建

Python 脚本程序，如图 1-17 所示——窗口的标题栏显示了程序的名称，初始文件名为 untitled，
带有符号*，表示程序还没有保存。 

 
图 1-15  Python 自带的集成开发环境 
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图 1-16  启动 Python 文件模式                     图 1-17  新建 Python 脚本程序 

(2) 在图 1-17 所示的窗口中编写第一个 Python 程序，并依次选择 File→Save 命令，将程序

保存为 hello.py 文件，如图 1-18 所示。 

 
图 1-18  Python 文件模式的程序 

(3) 在图 1-18 所示的窗口中依次选择 Run→Run Module 命令，即可运行当前的 Python 程

序，并在 shell 中显示运行结果，如图 1-19 所示。 

 
图 1-19  Python 程序的运行结果 

打开已有 Python 程序的方法是：在 IDLE 窗口中依次选择 File→Open 命令，选择想要打开

的文件夹和 Python 程序即可；也可在文件夹中右击想要打开的 Python 程序，依次选择 Edit with 
IDLE 命令和 Edit with IDLE 3.8(64-bit)命令即可。 

1.4.3  Python 常用的其他一些集成开发环境 

除了 Python 自带的集成开发环境 IDLE 之外，还有一些被广泛使用的其他集成开发环境，

如 PyCharm、Spyder、Vim 等。从事数据分析和机器学习工作的人士，也可以直接安装 Anaconda，
因为 Anaconda 包含了 conda、Python 及 NumPy、SciPy、matplotlib 等数量超过 180 个的科学包

及其依赖项。  
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1.5  初识 Python 程序 

1.5.1  把 Python 解释器当作计算器使用 

Python 解释器可以作为计算器使用，在 IDLE 交互模式下，输入一行数学表达式，按回车

键，即可返回运算结果。 
例 1-1  在 IDLE 交互模式下，计算数学表达式的值。 

>>> 99 + 88 - 5*6 
157 
>>> (18 + 36)*7 / 2 
189.0 
>>> 2 ** 8 
256 
>>> 2 ** 0.5 
1.4142135623730951 
>>> 17 // 3 
5 
>>> 17.0 // 3 
5.0 
>>> 17 / 3 
5.666666666666667 
>>> 17 % 3 
2 
>>> 

说明： 
以上表达式的语法很直白：运算符+、-、*和/代表的就是通常的加、减、乘、除。 
整数(如 88 )的类型是 int，带有小数部分的数字(如 189.0)的类型是 float。 
除法(/)永远返回一个浮点数(float)。 
使用//运算符时，结果将丢掉任何小数部分。 
可使用%运算符计算余数。 
可使用**运算符计算幂的乘方。 
那么，如何计算三角函数、指数函数、对数函数的值呢？比如 sin(π/6)、sin(2)、ln2 等。直

接输入，系统会报错，如图 1-20 所示。 

 
图 1-20  系统发出的报错信息 

导入系统自带的 math 标准库，即可解决相关问题。 
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例 1-2  导入并使用 math 标准库。 

>>> import math 
>>> math.sin(2) 
0.9092974268256817 
>>> math.sin(math.pi/6) 
0.49999999999999994 
>>> math.log(2) 
0.6931471805599453 
>>> 

说明： 
math 标准库是内置的 Python 模块，import 语句用来导入模块。 
 .是成员运算符，用来调用模块中的函数或方法。 
导入 math 标准库之后，利用内置的 dir()函数，可以查阅 math 标准库中的内容： 

>>> dir(math) 
['__doc__', '__loader__', '__name__', '__package__', '__spec__', 'acos', 'acosh', 'asin', 'asinh', 'atan', 'atan2', 'atanh', 

'ceil', 'comb', 'copysign', 'cos', 'cosh', 'degrees', 'dist', 'e', 'erf', 'erfc', 'exp', 'expm1', 'fabs', 'factorial', 'floor', 'fmod', 'frexp', 
'fsum', 'gamma', 'gcd', 'hypot', 'inf', 'isclose', 'isfinite', 'isinf', 'isnan', 'isqrt', 'ldexp', 'lgamma', 'log', 'log10', 'log1p', 'log2', 
'modf', 'nan', 'perm', 'pi', 'pow', 'prod', 'radians', 'remainder', 'sin', 'sinh', 'sqrt', 'tan', 'tanh', 'tau', 'trunc'] 

>>>  

利用内置的 help()函数，可以查阅相关函数或方法的使用说明： 

>>> help(math.gcd) 
Help on built-in function gcd in module math: 
 
gcd(x, y, /) 
    greatest common divisor of x and y 
>>>  
>>> math.gcd(24,90) 
6 
>>> 

math 模块中的内置函数 gcd(x,y)能够返回 x 和 y 的最大公约数。 

>>> help(math.factorial) 
Help on built-in function factorial in module math: 
 
factorial(x, /) 
    Find x!. 
     
    Raise a ValueError if x is negative or non-integral. 
 
>>> math.factorial(4) 
24 
>>> 

math 模块中的内置函数 factorial(x)能够返回 x 的阶乘。 
学习 Python 语言时，请一定充分利用好系统的帮助文件。 
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1.5.2  Python 程序示例 

Python 语言的特点之一就是入门简单，关键字相对较少，结构简单，语法定义明确，非常

接近自然语言。阅读编写良好的 Python 程序，就像读英语一样轻松。例 1-3 是一个计算身体健

康指数 BMI 的 Python 程序，试着读一下这个程序，暂时忽略语法含义，看看是否能够读懂；

按照程序设计的 IPO 方法分析一下这个程序，思考一下如何利用 Python 编程求解实际问题。 
例 1-3  编程计算身体健康指数 BMI，从键盘输入人体的身高和体重。 

1   # -*- coding: utf-8 -*- 
 
2   ''' 
3   BMI 身体健康指数计算 
4   作者、时间、版本号等 
 
5   BMI:Body Mass Index，身体健康指数 
6  BMI = 体重(单位 kg)/(身高(单位 m))^2 
7  国际上常用的衡量人体肥胖和健康程度的重要标准，主要用于统计分析 
 
8  国内 BMI 值(kg/m^2)： 
9   <18.5，偏瘦； 
10  18.5~24，正常； 
11  24~28，偏胖； 
12  >= 28，肥胖。 
13  ''' 
 
14  height = eval(input("请输入您的身高(单位为米)：")) 
15  weight = eval(input("请输入您的体重(单位为千克)：")) 
 
16  bmi = weight/(height ** 2)      #计算身体健康指数 
 
17  print("您的 BMI 指数为：",bmi) 
 
18  # 判断身材是否合理 
19  if bmi < 18.5: 
20     print("您偏瘦，请加强营养！") 
21  elif bmi >= 18.5 and bmi < 24: 
22     print("恭喜您，体重正常，请注意保持！") 
23  elif bmi >= 24 and bmi < 28: 
24     print("您偏胖，请加强锻炼！") 
25  else: 
26     print("您体重过大，请适度节食、加强锻炼！") 

运行 IDLE，打开该程序，依次选择 Run→Run Module，进入 shell 界面，按照提示“请输

入您的身高(单位为米)：”输入 1.7 并回车，再按照提示“请输入您的体重(单位为千克)：”输

入 80 并回车，得到的计算结果如图 1-21 所示。 
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图 1-21  计算结果 

这是一个编码格式较规范的程序，通过分析该程序，希望大家能够初步了解 Python 语言的

编码规范，逐步养成良好的编程习惯，以编写出格式规范的代码。 
第 1 行“#-*- coding:utf-8 -*-”是编码格式声明，在 Windows 平台上必须位于 Python 文件

的第一行。由于 Python 3.x 版本默认将程序保存为 UTF-8 格式，因此一般情况下，第 1 行代码

可以省略。 
从第 2 行的三个单引号'''(或三个双引号""")开始，到第 13 行的三个单引号'''(或三个双引号

""")结束的部分是文档字符串。文档字符串是包、模块、类或函数里的第一条语句，通常包含

版本信息、参数说明、功能说明等，用于表明如何使用这个包、模块、类或函数(方法)，甚至

包括使用示例和单元测试。 
第14行的height = eval(input("请输入您的身高(单位为米):"))是输入语句，作用是利用 input()

函数接收用户的键盘输入，并利用 eval()函数将输入的字符串转换为数值，然后赋值给变量

height，以便进行数学运算。 
第 15 行同第 14 行，作用是将用户从键盘输入的数据赋值给变量 weight。 
第 16 行的 bmi = weight/(height ** 2)是赋值语句，作用是将等号右边的数学表达式的计算结

果赋值给变量 bmi。另外，#后面的文字是行注释。 
第 17 行的 print("您的 BMI 指数为：",bmi)是输出语句，作用是输出计算出的 BMI 值。 
第 18 行的“#判断身材是否合理”是块注释语句，用于说明下方语句块的功能。 
第 19~26 行是多分支结构的 if-elif-else 语句，作用是根据计算出的 BMI 值和国内的 BMI

指标体系，判断用户的身材是否合理并输出结果。 
其实，这个语句块很好理解。我们可以将其看作英语，试着翻译一下。 
第 19 和 20 行是一条完整的语句，第 20 行相对于第 19 行缩进了 4 个空格以表明逻辑相关

性，可翻译为：如果(if)bmi < 18.5 真，输出"您偏瘦，请加强营养！"。 
接着，第 21 和 22 行是一条完整的语句，可翻译为：否则，如果(elif)bmi >= 18.5 and bmi < 

24 真，输出“恭喜您，体重正常，请注意保持！”。 
接着，第 23 和 24 行是一条完整的语句，可翻译为：否则，如果(elif)bmi >= 24 and bmi < 28 

真，输出“您偏胖，请加强锻炼！”。 
最后，第 25 和 26 行是一条完整的语句，可翻译为：否则(else)，输出“您体重过大，请适

度节食、加强锻炼！”。 
例 1-3 中的程序还不够完善，还有许多需要改进的地方。请大家积极思考该程序还有哪些

不足，在哪些方面还可以改进，你希望程序是什么样的，等等。随着今后的学习，希望大家利

用所学知识不断地完善这个程序。对于程序设计来说，没有最好，只有更好！ 
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1.5.3  Python 程序编码规范 

Python 采用 PEP 8——Style Guide for Python Code 作为编码规范，在这里，我们结合例 1-3，
对 Python 编码规范做简要说明。 

语句：通常一行书写一条语句，每条语句的最大长度为 79 个字符；语句过长时，可以

换行书写，换行时可以使用反斜杠\，但最好在语句的外部加上一对括号，比如( )、[ ]
或{ }。 

注释：对于不是一目了然的代码，应在行尾添加注释。注释通常以#和一个空格开始，

和语句在同一行，但至少要用两个空格和语句分开；对于复杂的操作，应在操作开始

前写上若干行注释，每行都要以#和一个空格开始，形成块注释。 
缩进：每个缩进层级使用 4 个空格，不要使用 Tab 键缩进代码。 
空行：使用必要的空行可以增强代码的可读性。通常情况下，在编码格式声明、模块

导入、常量和全局变量声明、顶级定义(如函数或类的定义)之间空两行，而在方法和函

数定义之间空一行。另外，在函数或方法内部，可以在必要的地方空一行以增强可读

性，但应避免连续空行。 
空格：通常情况下，在二元运算符的两侧各加一个空格；不要在逗号和冒号的前面加

空格，但应该在它们的后面加空格；在函数的参数列表中，逗号之后要加一个空格；

左括号之后、右括号之前不要加空格。 
文档字符串：文档字符串是包、模块、类或函数里的第一条语句，可通过对象的 doc

成员自动提取，并由 pydoc 使用。通过导入模块，可利用 help()函数查看文档字符串的

内容，如图 1-22 所示。 

 

BMI 身体健康指数计算 
、 、 

健康 

~ 
~ 

 
图 1-22  查看例 1-3 中的文档字符串 
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1.5.4  Python 的帮助文档 

学习 Python 语言难免会遇到各种问题，我们必须学会充分利用 Python 的帮助文档解决相

关问题。 
在 IDLE 环境下，依次选择 Help→Python Docs 命令，如图 1-23 所示，即可进入 Python 文

档初始界面，如图 1-24 所示。 

 
图 1-23  依次选择 Help→Python Docs 命令 

 
图 1-24  Python 文档初始界面 

在图 1-24 所示的 Python 文档初始界面中，单击目录中的 Python Module Index 条目，即可

进入 Python Module Index 界面，如图 1-25 所示，可以按索引查找相关模块的帮助信息。 
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图 1-25  Python Module Index 界面 

在图 1-24 所示的 Python 文档初始界面中，依次双击目录中的 The Python Standard Library
→Built-in Functions 条目，即可进入 Built-in Functions 界面，如图 1-26 所示。单击想要查看的

Python 内置函数，即可得到对应的帮助文件。 

 
图 1-26  Built-in Functions 界面 

在实践中，更常用的方法是，随时利用 Python 内置函数 help()查找有关主题的帮助文档。

例如，在命令提示符<<<后输入 help(id)后，按回车键即可得到有关 id()函数的帮助文档，如

图 1-27 所示。 
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图 1-27  help()函数用法演示 

另外，互联网上也有各种资源，大家可以充分利用。 

1.6  习    题 

一、选择题 

1. Python 是一种(    )类型的编程语言。 
A. 机器语言 B. 解释 C. 编译 D. 汇编语言 

2. Python 语言通过(    )来体现语句之间的逻辑关系。 
A. {} B. () C. 缩进 D. 自动识别逻辑 

3. 以下不属于 Python 语言特点的是(    )。 
A. 语法简洁 B. 依赖平台 C. 支持中文 D. 类库丰富 

二、编程题 

1. 计算(1 + 0.01)365和(1-0.01)365 的值，请谈一下你的感想。 
2. 参照例 1-2，计算 100 × cos 18°的值。 
3. 温度的刻画有两种不同的体系，分别是摄氏(Celsius)温度和华氏(Fabrenheit)温度，请参

照例 1-3，编程进行两种体系下的温度之间的转换： 
(1) 从键盘输入摄氏温度，转换为相应的华氏温度。 
(2) 从键盘输入华氏温度，转换为相应的摄氏温度。 
其中，转换公式如下： 

Celsius = (Fabrenheit-32) / 1.8 
Fabrenheit = Celsius×1.8 + 32 
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